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1. CX1000概述 

 

CX1000是倍福公司新一代的控制系统，它集工业PC和硬件PLC的精华于一体，

即可以完成复杂的自动化控制任务，又可以运行HMI程序。 

CX1000相当于一个小型的工业PC，其操作系统分为Windows CE.NET和嵌入式

Windows XP两种版本。其中基于嵌入式Windows XP的HMI编程方式和普通PC机上

的编程方式基本相同，而基于Windows CE.NET的HMI编程方式分两种，本文介绍

其中的一种。 

基于Windows CE.NET的HMI编程方式： 

 使用微软公司的Embedded Visual C++或Visual Studio .Net软件包自行开发

HMI应用程序 

 使用第三方提供的SCADA组态软件开发应用程序 
 
1.1 使用Embedded Visual C++或Visual Studio .Net软件包开发HMI应用程序 

在 CX1000 Windows CE.NET 版本中，支持使用微软公司的Embedded Visual 

C++或Visual Studio .Net软件包自行开发HMI应用程序，Windows CE.NET的应用

程序也是使用BECKHOFF公司提供的ADS动态库从而实现和CX1000的数据通讯。 

1.2 使用第三方提供的SCADA组态软件 

目前，有五种第三方SCADA软件的CE版本为倍福产品提供了驱动程序，实现

了无缝连接。它们的共同点是，在CX1000中安装后，其对应的实时运行核绑定在

CX1000的CompactFlash卡中。这些SCADA软件可以从倍福订货，但用于程序开发

的SCADA软件包应当向相应的厂商索取，倍福不提供。 

CX1000上可用的SCADA软件： 

 Zenon 

 PanelWorX 

 Qvis 

 Movicon 

 InduSoft 

CX1000相应的HMI订货号： 

CX1000的HMI订货号 说明 

CX1800-0001 Zenon CE.NET运行核 

CX1800-0002 PanelWorX CE.NET运行核 

CX1800-0003 Qvis CE.NET运行核 

CX1800-0004 Movicon CE.NET运行核 

CX1800-0005 InduSoft CE.NET运行核 

本文介绍其中一种第三方SCADA软件，即Movicon CE，内容主要包括软件的安装、

Movicon编程和应用程序开发举例。 
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2．软件安装 

 

2.1 系统需求 

在基于Windows CE.NET的CX1000上进行HMI开发，需要相应的硬件和软件。 

2.1.1 硬件需求 

 CX1000 

倍福CX1000产品中，型号是CX100x-xx1x的能够运行用Movicon开发的HMI。此外，

CX1000中还应当预装TwinCAT PLC或TwinCAT PLC + NC-PTP软件，以实现HMI和

外围I/O的通讯。 

 PC机 

用于开发在CX1000上运行的HMI程序。 

2.1.2 软件需求 

 倍福TwinCAT软件 

 CX1000远程桌面管理软件CERHOST 

 Movicon CE.NET运行核CX1800-0004 

 Movicon开发软件包 

 

2.2 安装软件 

2.2.1 在PC机上安装TWinCAT2.9 

在PC上插入TWinCAT2.9安装光盘，自动播放后，点击TwinCat2.9目录下的

Installation，然后点击Installation TwinCAT2.9，则开始TwinCAT的安装。在安

装过程中，当出现“输入用户信息”画面时，你必须在该对话框中输入序列号，你

可以在购买的TwinCAT协议中找到序列号。如果你想安装TwinCAT的演示版本，应使

该框为空。 

 
接下来是选择安装级画面，必须选择下面安装级中的一种 
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产品级别说明： 

TwinCAT CP 

包含Beckhoff控制面板特殊功能的所需组件(UPS, S-键, ...) 

TwinCAT IO 

(用户模式)程序可直接存取I/O设备，该级不包括PLC。 

TwinCAT PLC 

TwinCAT PLC中包含 IEC61131-3 软件开发工具。 

TwinCAT NC PTP 

除包含PLC外，本模块还包括用于控制PTP轴的NC/CNC功能。 

TwinCAT NC I 

除包含PLC外本模块还包括用于3D插补驱动的NC功能。 

选择安装类型画面： 

选择TwinCAT作为30天测试版本登录安装或需要更多信息,如果你没有登录授权号可

选择‘安装30天版本’并且在30天之内登录。 
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组件选择画面： 

缺省时不是所有的TwinCAT组件都安装 

 
选中TwinCAT IO和TwinCAT Scope View即可。 

安装结束后，重启计算机即完成安装。 

 

2.2.2 在PC机上安装Movicon开发软件 

把Movicon 9.1安装在PC机上，用于开发HMI，开发完成后导出成为Movicon CE

工程，以便在CX1000上运行。操作如下： 

插入Movicon安装光盘，打开Mov9.1文件夹中的Setup文件夹，单击Setup.exe，

系统则开始安装程序。在安装过程中，当出现用户信息画面时，输入相应的用户信

息即可。 
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接下来是选择安装语言画面，选择English即可。 

 
 

然后出现选择安装类型画面，应当选择Typical。 
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在随后出现的画面中点击Next按钮则可完成Movicon的安装。 

 

 

2.2.3 在CX1000上安装Movicon CE.NET运行核 

把Movicon CE.NET运行核安装到CX1000上，以便能够运行Movicon CE HMI。软

件的安装可通过两种方式，一是借助于连接到CX1000的显示器和USB鼠标完成操作，

二是借助于倍福的远程桌面管理软件CERHOST完成操作。 

 借助于连接到CX1000的显示器和USB鼠标 

CX1000带有DVI和USB接口才可使用这种方式。由于CX1000相当于一个小型IPC，

连接上显示器和鼠标，使用则如同普通PC。CX1000的DVI接口通过转接器可以连

接一个VGA接口的显示器，USB鼠标则连接CX1000的USB接口。CX1000的画面如下： 
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 借助于倍福的远程桌面管理软件CERHOST 

在倍福的ftp网站： 

ftp.beckhoff.de/Software/embPC-Control/CE/Tools/RemoteDisplay 下载

CeRemDispHost.zip，解压缩该文件即可得到CERHOST.exe。用网线将PC机和CX1000

连接起来，首先把PC机的IP地址和CX1000的IP地址设置在同一网段（CX1000的IP地

址的出厂值是169.254.x.x），然后在PC上运行CERHOST.exe，点击菜单File下的

Connect，在Hostname中输入CX1000的名字，或者IP地址，然后点击OK，则可将CX1000

的画面在PC机上接管过来。 
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PC机接管的CX1000画面和CX1000连接的显示器上显示画面完全相同。 

 

在倍福的ftp网站：ftp.beckhoff.de/Software/embPC-Control/CE/Platforms  

下载CX1800-0004_HMI_Movicon，即Movicon CE.NET运行核。用U盘或者读卡器将

CX1800-0004_HMI_Movicon文件夹中的CX1800-0004_HMI_Movicon.I586.CAB拷贝到

CX1000的CF卡中，运行该文件即可完成安装。 

2.2.4 在PC上安装TwinCAT驱动的补丁 

Movicon已经集成了TwinCAT驱动，但是驱动配置界面是德语的，需安装补丁，

才能变为英文界面。补丁向倍福上海办事处索要，把4个补丁文件拷贝到Movicon安

装路径下的Drivers文件夹中替换掉原来的文件即可，Drivers的缺省路径一般为：

C:\Program Files\Progea\Mov91\Drivers。 
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3. Movicon编程 

 

3.1 Movicon工程的组成结构 

一个Movicon工程包括资源、对象和逻辑。资源分为两种，一般资源和综合资源。

其中一般资源用于制作用户画面即图形部分和Basic脚本。综合资源包括String 

Table，Variable，Images，Logic等。一个Movicon工程的组成结构图如下： 

 
 

3.2 进入Movicon集成开发环境 

打开Movicon，首先出现新建工程画面。新建一个工程，命名为CXTest，保存位

置为E:\Movicon\CXTest，工程类型选择Enterprise Project。如下图： 

 
点击OK后，即打开开发环境。 
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一个新的工程打开后，出现一个树形的资源窗口，根部是缺省的工程名Project1,

此名称可以修改，首先选中Project1,点击右键菜单的Properties…，修改Project

的名字，在此修改为CX_Demo。Project1下有一个窗体Main，其名称也可通过点击右

键菜单的Properties…修改。 

 
注意：如果开发的HMI要在CX1000上运行，则Load/Save From File不要选中。 
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修改后的工程资源窗口如下： 

 
 

3.3 系统设置Setting 

在开发Movicon HMI之前，用户应根据实际情况先对系统进行设置。系统设置包

括系统变量设置、通讯驱动设置、Modem设置、PID设置、Basic Script Startup设

置以及Server设置等多项内容。下面对其中的几项进行介绍。 

 

3.3.1 系统变量设置 

点击工具栏菜单Settings->System Variables，则弹出设置界面。 

 
在此窗口设置工程中需要的变量数、定时器个数以及报警个数等参数。 

 Input/Output/Flags：设置工程需要的外部变量和内部变量的字节数。 

注意：系统设置的变量字节数不能超过购买的License中规定的数目。 

 Timers：设置工程中能够使用的定时器个数。 

 Alarms/Messages：设置系统必须处理的报警和信息个数。 
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 Retentive Flags：选中Enable，则地址在50和90之间的内部变量在系统掉电时

能保持现有状态。掉电保持的变量最多可以设置64K字节。  

3.3.2 用户设置 

    点击工具栏菜单Settings->Users，则弹出用户设置界面。 

 
为了安全合理地使用Movicon HMI，应该设置不同级别的用户。 

 添加新用户 

点击Users窗口中的Add按钮，则弹出User Profile窗口，在此窗口设置用户的

信息和级别。 

 
• Name：用户的名字，必须填写。 

• Description：该用户的详细信息，必须填写。 

• Password：该用户的密码，最少4个字符，最多32个，必须填写。 

• Level：该用户的级别，必须选择其中的一个。可选则的最高级别是10，该级

别的用户可以进入工程的编程环境。级别为9的用户可以操作HMI中的命令。

前8个级别的用户权限则比较低。 

第 15 页 共 63 页 



德国倍福电气有限公司上海代表处 
地址：上海市延安东路222号外滩中心3603室 

网址：http://www.beckhoff.com.cn 
电话：(021) 63351366 63291558 传真：(021) 63351355 
 

用户还可以分组，以便管理。 

 

 Activate Protection 

选中该项，则密码管理生效。 

注意：密码管理生效后，必须有一个级别为10的用户才可以退出运行环境进入

编程环境。 

   选中Activate Protection，点击Users窗口中的OK按钮时，弹出下面的窗口。其

中“Develop”是一个级别为10的用户。 

 
若系统没有级别为10的用户，点击OK按钮则弹出一个警告信息，不允许密码生效。 

 Auto-Log OFF  

选中该项，并在后面的编辑框中输入时间，例如2，则在运行环境下，登录的用

户如果在2分钟内没有任何操作，则自动退出。 

说明：不同级别的用户设置完毕后，应该在工程中使用，比如可以为HMI中的操

作命令设置密码，使级别等于或高于该密码的用户才可以操作该命令。在后面的章

节3.11.5中有这方面的介绍。 

 

3.4 Movicon资源 

资源是Movicon工程的基础。综合资源不可以删除或复制，可以通过工具栏菜单

中的Resource访问它们，也可以通过直接点击开发环境中左侧的图标访问。它们包

括： 
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还有一种类型的资源，在一个Movicon工程中可以有多个，而且还可以根据需求

分组。这些资源有： 

 
 

 

3.5 Synoptics资源 

3.5.1 Synoptic资源Main  

Synoptic资源是工程运行时的窗口画面，一个新的工程包含缺省的synoptic资

源Main，还可以再添加多个synoptic。不同窗口的切换并不是根据树形资源窗口中

的synoptic名称，而是根据Synoptic configuration中的设置。Movicon工程运行时，

首先启动的是Synoptic configuration中保存为Main的画面，在Synoptic 

configuration中，可以选取工程中的任意一个synoptic资源保存为Main。在工程的

缺省设置中，树形资源窗口中的synoptic资源Main在Synoptic configuration中保

存为Main。 

Synoptic窗口Main的大小和背景色等属性可以设置。在树形资源窗口中双击

CX_Demo下的Main则打开其窗口。 

 

双 击
Main 
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Main窗口： 

 
点击工具栏菜单View->Properties…，弹出其属性窗口。也可通过点击鼠标右键菜

单的Properties…弹出属性窗口。 

 
属性说明： 

 General：Background Color…，设置窗口的背景色；Background Bitmap，设

置窗口的背景位图，通过Browse…按钮选取位图。 

 Style：设置窗口的尺寸和位置。 

Width，宽度；Height，高度；X，x向坐标值；Y，y向坐标值 
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3.5.2 创建新的synoptic  

在资源窗口的任一位置点击鼠标右键，在弹出的菜单中选择New，则弹出资源窗

口。也可以通过工具栏菜单Resource->New弹出此窗口。 

 
选择Synoptic，点击OK确认，则一个新的Synoptic插入工程中，同时该Synoptic窗

口打开，关闭该窗口回到工程的资源窗口，则发现新添加的Synoptic缺省名称是

Synoptic1,可以修改其名称。选中Synoptic1,点击右键菜单的Properties…，打开

其属性窗口。也可以在选中Synoptic1后，点击工具栏菜单Resource->Properties…

打开属性窗口。 

 
Resource Name中输入新的名称例如Line1。 

注意：如果开发的HMI要在CX1000上运行，则Load/Save From File不要选中。 

 

3.5.3 设置Synoptic Configuration 

由于不同窗口的切换是根据Synoptic configuration中的设置，所以需要设置

Synoptic configuration。在工程资源窗口双击Line1,打开Line1的窗口，点击工具

栏菜单Windows->Configuration->Save…，打开Synoptic Configuration窗口。 
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Synoptic Configuration窗口： 

 
输入一个名称，例如Line1，按OK按钮确认即可。 

如果要设置Line1为工程的启动画面，则输入Main，点击OK按钮，则弹出信息窗口。 

 
点击“是”按钮即可。这样窗口Line1即成为工程运行时的启动画面。 

如果工程中有多个synoptic，则每个都需要安装Line1的方式设置。每个

synoptic在Synoptic Configuration时保存的名字最好和其在树形资源窗口中的名

称相同。要打开整个工程的Synoptic Configuration，可以点击工具栏菜单

Windows->Configurations->Open…。 

第 20 页 共 63 页 



德国倍福电气有限公司上海代表处 
地址：上海市延安东路222号外滩中心3603室 

网址：http://www.beckhoff.com.cn 
电话：(021) 63351366 63291558 传真：(021) 63351355 
 

 
3.6 Menu资源 

Movicon 工程的窗口画面中允许插入一些弹出式菜单，这样可使设计的 HMI 更
加完美。要插入菜单，点击工具栏菜单 Resource->New，弹出新资源窗口，选择 Menu
后，按 OK 确认。 

 
打开的新资源 Menu 缺省名是 Menu1，在资源窗口选中 Menu1 后，点击右键菜单的

Properties…，在其属性窗口中可对其重新命名，例如 Motor。 
注意：如果开发的 HMI 要在 CX1000 上运行，则其 Load/Save From File 不要选中。 

 
双击 Motor 菜单则打开其设计窗口。 
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点击左下角的 New 按钮，弹出 Menu Item Properties 窗口。 

 
属性说明： 

 General：设置Caption和 Prompt属性，即菜单名称和弹出的信息都是 Start Motor。 

 
 Execution：设置 Command，左侧选择 Set variable，右侧选择变量 Motor_Start，

并添加“，1”，表示当用户点击弹出的菜单 Start Motor 时，变量 Motor_Start

的值设置为 1。 
同样，再添加新的 Item，其 Caption 和 Prompt 命名为 Stop Motor。Execution 设置：

左侧选择 Set variable，右侧选择变量 Motor_Start，并添加“，0”，表示当用户点

击弹出的菜单 Stop Motor 时，变量 Motor_Start 的值设置为 0。 
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这样，菜单 Motor 添加了两个子菜单，Start Motor 和 Stop Motor。其窗口如下： 

 
 

3.7 Dialog资源 

Movicon工程的窗口画面中允许插入对话框，当需要设置数据和选择参数时，

使用对话框非常方便。要插入对话框，点击工具栏菜单Resource->New，弹出新资源

窗口，选择Dialog后，按OK确认。 
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打开的新资源 Dialog 缺省名是 Dialog1，在资源窗口选中 Dialog1 后，点击右键

菜单的 Properties…，在其属性窗口中可对其重新命名，例如 Set Motor Speed。 
注意：如果开发的 HMI 要在 CX1000 上运行，则 Load/Save From File 不要选中。 

 
双击 Set Motor Speed 对话框则打开其设计窗口。 

 
 

点击右键菜单Properties…则弹出其属性窗口。 

 
属性说明： 
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 General：X、Y，定义对话框的位置。Title，对话框的名字，例如Set Motor Speed。 

 Style：设置对话框的风格，例如是否需要显示对话框的Title等。 

 

如果Motor的速度分为低速、中速和高速，那么对话框中包括三个单选按钮，分

别对应低速、中速和高速。由于它们中的每一个都不是独立的，要受其它按钮的制

约，所以它们必须属于同一个组。另外还有一个OK按钮和一个Cancel按钮。 

点击工具栏菜单Insert->Group Box，鼠标变成十字形，按着左键拖动鼠标则可

在对话框窗体上画出一个Group，其名称、字体的大小，以及字体的对齐方式都可在

其属性窗口中修改，例如名称改为Motor Speed Setting，对齐方式为Center等。 

 
 

 

3.7.1 Radio Button 
按照插入Group Box的方式插入3个Radio Button，名称分别设为Low Speed、

Middle Speed和High Speed，对齐方式都是Left。 
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为使三个Radio Button为同一组，Low Speed的Group属性选中，而其它两个的Group

属性不能选中。 

 
Execution属性：Variable中选择一个Word型变量，例如Motor_Spd。三个Radio 

Button连接的变量都为Motor_Spd。当用户分别选择Low Speed、Middle Speed或High 

Speed时，Motor_Spd的值分别变为0、1、2。当然这三个Radio Button插入的先后顺

序应该是Low Speed、Middle Speed、High Speed。 
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3.7.2 Button 
同样按照插入Group Box的方式插入2个Button，名称分别设为OK和Cancel。 

 
Style：Align选择Centre，即对齐方式为中间。 

Execution： 

OK按钮的Command Type选择OK- Close Dialog，它相当于Enter的功能，用户按

下此键则保存用户的设置然后关闭该对话框。 

Cancel按钮的Command Type选择Cancel- Close Dialog，它相当于ESC的功能，

用户按下此键则关闭对话框而不保存设置。 

 
 

3.8 Images资源 

Images资源相当于放置BMP位图的容器，在Images中可添加多个BMP位图，这些

位图用于制作动画或者在Button、Menu、Dialog上显示。Images中可插入的图片格

式有BMP、GIF、WMF或EMF。一个Movicon工程中只能有一个Images，且不可删除。 

要在Images中添加位图，点击工具栏菜单Resource->Images，弹出Image List窗
口。 
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Image List窗口： 

 
 
 
 
点击左下角的New按钮，弹出Image Properties窗口。 

第 28 页 共 63 页 



德国倍福电气有限公司上海代表处 
地址：上海市延安东路222号外滩中心3603室 

网址：http://www.beckhoff.com.cn 
电话：(021) 63351366 63291558 传真：(021) 63351355 
 

 
属性说明： 

 General：ID，位图的标示名称，缺省为SIM0001，可以自定义，例如Pic1。 
            File，点击Edit…按钮，弹出画图编辑器，可自行编辑图片。点击Browse

按钮，可添加位图文件。 
          Embed File into Project，选中此项则将位图嵌入工程中。 
注意：如果开发的HMI要在CX1000中运行，则位图文件要放在本工程的文件夹中。 
 Information：位图的大小等信息。 

添加位于本工程文件夹中的位图文件S1后，Image Properties窗口： 

 
按照上述方法可添加多个位图。 
注意：位图不要添加太多，工程运行时，会将Images中所有位图调入内存中以便能
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够在窗口中快速显示，故位图太多会占用过多的内存，导致系统性能降低。 
 
3.9 TwinCAT驱动配置 

为了读写TwinCAT设备的变量，应该配置TwinCAT驱动。点击工具栏菜单

Settings->Communication Drivers，则打开Communication Drivers画面。 

 
从Communication Drives的Avialable中选中TwinCAT,点击按钮Add->，则TwinCAT

的驱动添加进来。选中Installed中的TwinCAT，则Set…按钮有效，点击Set...按钮，

则出现Protocol Settings Driver TwinCAT画面。 
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3.9.1 左侧窗口设置： 

 Router AMS Address:输入TwinCAT设备的AMS NetID。如果Movicon HMI要在

CX1000中运行，且读写运行在该CX1000中的PLC变量，则此处输入该CX1000的AMS 

NetID，例如192.168.1.50.1.1，采用缺省值Local也可以。 

 Task Sleep Time和Timeout两项采用缺省值即可，Var.Optimization Time设置

为零。 

 Supervisor Synchronous Start按钮：将Movicon的启动和采集TwinCAT PLC数

据同步，如果此按钮被按下，则至少从PLC读取一次数据后，Movicon才能启动。

缺省是不同步的。 

3.9.2 右侧窗口设置： 

 Task Name:可随意取个名字，任务名由字母和数字组成。例如：Data1。 

 Freq. Of esecut.：任务执行的频率（毫秒）。 

 Task Type:  

• Input，数据从TwinCAT PLC读取写进Movicon的工程变量中。 

• Output，数据从Movicon的工程变量读出写进TwinCAT PLC的变量中。 

• Input/Output：既有Input特性，又有Output特性。 

 Movicon Addressing： 

• Absolute，根据TwinCat PLC的地址访问变量。 

• Variable，根据TwinCat PLC的变量名访问其变量。 

 Device Addressing： 

• Device Port，ADS的端口号，例如TwinCAT PLC Run-Time 1的端口号是801。 

• Address，对于按地址访问变量方式，地址的定义为，%I（输入变量），%Q

（输出变量），%M（内部变量）。对于按变量名访问方式，地址的定义为，

[POU名称].[结构变量名].[变量名]。例如：MAIN.Var1，其中MAIN是POU名称，

Var1是MAIN的变量。 

• Data Format,选择变量的类型，byte, word, double word, 或者float。 

• Quantity,从TwinCat PLC读或写多少个Data Format定义的数据，如果Data 

Format中设置是Word，Quantity的设置是2,则从PLC读或写2个Word。 

 Additional Task’s Settings 

• Swap Bytes: 把要访问的变量交换其高低位字节。 

• Swap Words：把要访问的变量交换其高低位字。 

• Read On Request: 一般情况下不需要选中。 

3.9.3 中间部分的按钮说明： 

 Add：添加新的任务，要添加的任务名称不能和已有的任务名字相同。 

 Edit：当前的任务编辑修改后，按下此按钮才生效。 

 Delete：删除当前选中的任务。 

3.9.4 TwinCAT配置举例 

Movicon读取运行在CX1000的Run-Time1中的PLC程序的多个变量。 

 TwinCAT PLC中各个变量的定义如下： 
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arrVar     AT %MW0 : ARRAY[0..23] OF REAL; 

bVar1  AT  %QX0.0 : BOOL; 

bVar2   AT %QX0.1 : BOOL; 

bVar3  AT  %QX0.2 : BOOL; 

bVar4   AT  %QX0.3 : BOOL; 

bVar5   AT  %QX0.4 : BOOL; 

bVar6   AT  %QX0.5 : BOOL; 

 在Protocol Settings Driver TwinCAT画面中的设置： 

• 添加第一个Task，访问PLC中的变量arrVar。  

Task Name设为arrData，也可设置为其它名字； 

Movicon Addressing，选择Absolute，Absolute下方的地址设为20。地址的

设置根据Variable DB中的地址分配情况而定，和TwinCAT中的变量地址无关。

Device Port：设置为801，Run-Time1的端口号； 

Address：设置为%M0，arrVar的地址； 

Data Format：Float，arrVar的类型； 

Quantity：24，arrVar数组的元素个数。 

• 添加第二个Task，访问PLC中的6个bool量。  

Task Name设为bData； 

Movicon Addressing，选择Absolute，Absolute下方的地址设为10。 

Device Port：设置为801，Run-Time1的端口号； 

Address：设置为%Q0，第一个布尔量的地址； 

Data Format：Byte； 

Quantity：1。 

说明：由于PLC中6个布尔量的地址都是输出域中第一个Byte的其中一位，所

以读取起始地址为Q0的一个Byte则包含了6个布尔量。 
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    Task添加完毕后，在Movicon中定义Input或Output类型的变量，地址设为Task

中Absolute下方的地址，则可以在用户窗口中访问CX1000中的PLC变量了。 

 

 

3.10  Variable DataBase资源 

SCADA系统要监视和控制设备的运行，需要访问设备的变量，因此应该在Movicon

工程中建立变量数据库，以实现数据的交换。变量数据库在Movicon工程中的功能如

下图所示： 

 
     

第 33 页 共 63 页 



德国倍福电气有限公司上海代表处 
地址：上海市延安东路222号外滩中心3603室 

网址：http://www.beckhoff.com.cn 
电话：(021) 63351366 63291558 传真：(021) 63351355 
 

点击工具栏菜单Resource->Variable DataBase，则打开Variabel DB窗口。 

 
在Movicon工程中可以创建外部变量（输入变量Input，输出变量Output）和内

部变量Flag。在Variable DB窗口中可添加，删除和编辑变量。 

点击菜单Resource->New Variable，则添加新的变量，也可以通过点击左下角

的New按钮添加变量。 

 

 
General属性说明： 

 Variable，变量名称自定义，如果要访问PLC中的布尔量bVar1,即上一章驱动配

置中添加的Task bData,这里可命名为b1。 

 Description，对变量的描述，这里的描述为bVar1 of PLC。 

 Type，因为是布尔量，所以选择Bit。 
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 Data，选择Output，由于bData这个Task的Type是Input/Output，故是可读写的；

Address设置10,因为bData中Absolute下方的地址为10，Bit设置0，因为PLC中

的布尔量bVar1的地址是QX0.0。 

 

如果要添加一个访问PLC中的布尔量bVar2的变量b2,则只需要把Description和

Bit的设置修改就可以了,Bit应该设置为1。 

 
 

如果要添加一个访问PLC中的变量arrVar[1]的变量arr2,由于TwinCAT PLC中的

REAL类型变量占4个字节，故Type应该选则Float(32 bit…)。Address设置为24，因

为上一章驱动配置中添加的arrData这个Task，其Absolute下方的地址为20，且一个

变量占4个字节，所以要访问arrVar[1]，Address中应该设置为24。 

 
 

内部变量的定义和外部变量的定义方式相同，区别在于Data的设置，应该选择

Flag类型。要删除某一个变量，则选中该变量，然后点击Variable DB窗口下方的

Delete按钮即可。要编辑某一个变量，则点击Properties按钮，弹出其属性窗口，

修改后关闭即可。 

注意：变量的地址不能重叠。要检查定义的变量的地址是否发生重叠，可点击工具

栏菜单Edit->Verify。 
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弹出的信息窗口中表明是否有冲突，例如定义两个WORD型内部变量，它们的地址都

是55,则信息窗口中出现如下错误信息： 
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3.11 用户界面窗体 

用户界面是用户监视和操作设备的窗口。Movicon工程的窗体是前面所讲的资源

Synoptic，在Synoptic上放置各种Object和Symbol，就可以做出多彩的用户画面。 

 
3.11.1 Symbol 

点击工具栏菜单Insert->Symbols，弹出Symbols菜单，选中其中的一项例如

Text，则可在窗体上放置一个Text文本。按照同样的方式在窗体添加一个Ellipse，

一个Rectangle，一个Vectorial Gauge。 

注意：如果Symbols的菜单内容呈灰色失效状态，则按F6或者点击菜单

View->Symbols，或点击鼠标右键菜单的View->Objects，则Symbols显示的内容呈有

效状态。 
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    这些Symbol的属性可以修改，例如修改椭圆的属性，选中椭圆后，点击鼠标右

键菜单的Properties则弹出其属性窗口。 

 
属性说明： 

 General：Line，椭圆的线宽；Border，有无边框以及边框的风格；Title，椭

圆上显示的文字；Line/Text Color…，设置椭圆的边界线的颜色；Background 

Color…，设置中间的填充色；Font…按钮，设置字体；Background不选中，则

椭圆背景色无效，呈透明状态。 
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 Style：设置字体的对齐方式；Gradient，设置颜色的渐变风格。 

 
 Images：设置位图，可以从工程中Images资源里添加的位图中选择任意一个。

通过下拉式按钮选择位图的ID，则该位图添加进来；Transparent，选中该项，

并设置和位图底色相同的颜色，则可去掉其底色；Stretch，选中该项，则位图

的大小随该椭圆的大小的改变而改变。 

 
 Dragging：选中Move后，该椭圆的位置可以和变量连接起来，当变量的值发生

变化时，椭圆的位置也随之改变。 

 
 Execution：此属性设置图形的动画。 

• Rotation，连接一个变量，当变量值改变时，则椭圆的转动角度也随之改变。 

• Text，连接一个变量，在椭圆上显示该变量的值。例如显示变量Motor_Spd
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的值，则在Variable DB中选择该变量；Format，对于Integer变量，选择“x”

即可，对应Float变量，则需要选择相应的小数位数，例如选择“x.xx”，则

显示两位小数。 

    
• Color中的Background，可使连接的变量的值改变时，椭圆呈现不同的背景色。 

• Visible，连接一个布尔量。例如，当该布尔量为1时椭圆可见，为0时不可见。

则设置画面如下： 

    
• Bitmap，制作动画。 

其它Symbol的属性设置和椭圆的设置基本相似，这里不再赘述。 

 

3.11.2 动画举例 

当一个内部布尔型变量bTest=1时，在矩形框内上显示一个旋转的动画。当

bTest=0时，动画停止旋转。 
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 首先在工程的Images中添加动画旋转过程的几个位图。本动画由三个位图构成，

分别为s1,s2,s3，在Images中的ID分别是S1，S2，S3。 

 
 先弹出矩形框的属性窗口，在Execution选项中选中Bitmap，然后点击Bitmap后

面的按钮，弹出Bitmap Threshold窗口。 
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Variable，选择变量bTest，它控制动画是否旋转。 

 点击Bitmap Threshold窗口右侧的Add按钮，弹出Bitmap List窗口。 

 
Variable，选择一个Word型内部变量即可，例如Rotate。 

Value，设为0。 

 点击Bitmap List窗口的Add按钮，弹出Bitmap窗口，添加位图。此时的位图是

动画不旋转时显示的位图。点击Bitmap窗口中的下拉式按钮，选择Images中添

加的位图，此处选择S1，即动画静止时显示位图s1。选择完毕点击OK按钮关闭

Bitmap窗口。 
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Mode：Transparent，选中该项，然后点击颜色设置按钮，设置成和位图的背景色相

同，则去掉位图的背景。 

Stretch，选中，则位图的大小要自适应矩形框的大小。 

设置完毕关闭Bitmap List窗口。再次在Bitmap Threshold窗口中点击Add按钮，重

新弹出Bitmap List窗口，设置如下： 

 
Value，设为1。 

Variable，仍然选择Rotate。 

通过点击Add按钮依次添加三个位图，S1，S2，S3，分别对应动画旋转中的三个状态。 

Mode：Continuous cycle，选中该项，即三个位图循环显示，刷新时间即Animation

的设置，此处设为100ms。 
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设置完毕，在Main窗口通过控制bTest变量的值，就可以控制动画的旋转了。 

 

3.11.3 Symbol模板库 

Symbol模板库中有丰富的Symbol可供随意使用，比如要插入一个电机到窗口中，

点击工具栏菜单Insert->Symbols->Template from Library，则打开模板库。 

 
双击选中的电机，则插入到窗体中。模板库中的Symbol使用方法同普通Symbol类似。 

 

3.11.4 Object 

点击工具栏菜单Insert->Objects，弹出Objects菜单，选中其中的一项例如

Button，则可在窗体上放置一个Button。按照同样的方式在窗体可添加其它Object。 

注意：如果Objects的菜单内容呈灰色失效状态，则按F5或者点击菜单

View->Objects，或点击鼠标右键菜单的View->Objects，则Objects显示的内容呈有

效状态。 

注意：Movicon CE中不支持的Objects：Potentiometer，Slider，Meter，Scale，

Spin，Clock，Annunciator。 

下面以Button为例介绍Object的使用。 

弹出Button的属性窗口。 
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属性说明： 

 General：Color and Released button，设置Button的颜色；Text Color，设

置Button上字体的颜色；Font，设置字体。 

 
 Style：Type，按钮的风格；Title，设置按钮上显示的文本。Align，文本的对

齐方式。 

 
 Execution：设置按钮的Command Type和Command。     

Command Type的类型非常多，本文只取其中的几个进行介绍。 

• 切换窗体 

 
Command中选择Line1，点击该按钮，则窗体切换到画面Line1。 

• 弹出菜单 
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Command中选择制作的菜单Motor，点击该按钮，则弹出Motor菜单。 

• 设置变量 

 
Command中选择变量bTest，并添加“,1”，点击该按钮，则变量bTest的值变为 

1。若不添加“,1”，点击该按钮则弹出一个输入框，用户可以输入1或0，关闭

输入框后生效。 

下图是工程运行时的界面。当用户点击OK按钮，输入1时，前面做的动画则

开始旋转；当用户输入0时，则动画停止旋转。 

 
 

• 关闭工程 
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选择Exit from MOVICON，点击该按钮，则关闭并退出Movicon工程。 

 

3.11.5 Button的密码设置 

为了安全使用HMI，应该为Button、Hot Region等用户操作命令设置密码，使不

同级别的用户操作权限不同。下面以Button为例介绍密码的设置。 

打开Button属性窗口的Execution选项。 

 
Password：输入8，则用户级别至少为8的用户才可以操作此按钮。工程运行时，点

击该按钮则弹出下面的窗口。 

 
输入一个级别为8的用户名和其密码，则该按钮的操作生效。若输入的用户级别小于

8，则无效。 

 

3.12 Basic Script资源 

Movicon CE中不支持Basic Script和Public Basic Script，因此本文不做介绍。 
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4. HMI开发实例 

 

在CX1000上运行的Movicon HMI必须先在PC上开发完成后，再导出到CX1000上。 

4.1 创建一个新工程 

打开Movicon，新建一个工程，例如：CXTest。工程类型选择Enterprise Project。

如下图： 

 
点击OK后，即打开开发环境。 

 

下面以此工程为例讲解如何在PC上开发一个简单的HMI。 

本工程用于化纤生产线的部分生产过程，画面有Main、Line1、Line2，Alarm

和Trend，在Synoptic Configuration中分别保存为Main、Line1、Line2，Alarm和

Trend。Main窗口中，要显示一些信息，还要添加几个按钮，以便切换到其它的画面。

Line1画面用于显示化纤生产线的导丝架、导丝机和浸油槽部分，Line2用于显示第

一牵伸机、油浴槽、第二牵伸机和蒸汽加热箱部分，Alarm用于显示报警信息，Trend

用于显示部分数据的实时曲线。  

 

4.2 Main画面 

打开Main画面的属性窗口，设置其大小(640x480)和背景图(main.bmp)，背景图

文件在该工程的文件夹中。然后在窗体上添加几个Text文本和几个按钮，分别设置

其属性。效果如下图所示。 
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按钮Line2的属性Execution设置如下图，Command选择Line2, 点击该按钮则切换到

画面Line2。 

 
同理，按钮Line1、按钮Trend和Alarm的Command属性分别设置为Line1、Trend和

Alarm。 

 

4.3 Line1画面 

打开Line1窗口，首先设置窗口的大小和背景色。尺寸设置和Main相同，宽度640,

高度480，背景色设置为淡蓝色。 

4.3.1 添加Symbols 

从Symbol模板库中调出一些图形插入到窗口中，比如要插入筒形容器，点击菜

单Insert->Symbols->Template from Library打开模板库。 
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双击选择的图形插入到窗口中，并根据需要调整成适当的尺寸。 

添加辊子、机架、电机、油泵、风机以及阀门等symbols。 

4.3.2 Symbol动画 

给添加的某些Symbols连接相应的变量，使之根据变量的变化而变化。本工程中，

当生产线开始工作后，辊子的轴、阀门变绿色，电机、油泵的ON标签变绿色，风机

的风扇开始转动。停止工作后，绿色全部变为灰色，风扇停转。 

 插入一个椭圆Symbol，设置其背景色为绿色，边框色为黑色，并把椭圆放置在

灰色辊子的中间。 
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选中属性窗口中Visible的复选框，然后点击其按钮，在Visible窗口中，

Variable：选择和椭圆的Visible对应的变量例如Roller_Visible；Condition：

输入可见的条件，例如当Roller_Visible＝1时，绿色椭圆可见，否则不可见，

只显示灰色的辊子，则在Value中输入1,选中第三个单选框，误差输入0。其中变

量Roller_Visible是工程已经定义的变量，它可以是内部变量，也可以是来自

TwinCAT PLC的输入变量。 

 插入一个文本Symbol，背景色设为绿色，字体颜色设为黑色，显示的字设为ON，

把此文本叠放在导丝机的灰色电机上，其Visible连接的变量是

Roller_Visible，可见条件设为等于1时可见，因此导丝机电机正常工作时，

Roller_Visible=1时，绿色ON标签可见，否则只显示灰色的电机。 

 从图形模板库调出一个阀门Symbol插入到窗口中，背景色设为灰色，再插入一

个同样大小的阀门，背景色设为绿色，把其Visible属性和某个变量例如

DaoSi_Pump_On连接起来，把绿色阀门叠放在灰色阀门上，这样当工作时，绿色

阀门的可见条件满足，绿色阀门可见，灰色阀门被遮住。当停止工作时，绿色

阀门不可见，灰色阀门呈现出来。 

 触发 Symbol 动画 
Symbol 动画由相连的变量触发，变量值的改变通过资源 Menu 实现，添加菜单

DaoSi_Motor，并为其添加两个子菜单，分别为 Start the Motor 和 Stop the Motor。
Start the Motor 子菜单的设置如下： 

 
 

 
 

同样，添加 Stop the Motor 子菜单，其 Caption 和 Prompt 命名为 Stop the Motor，
Execution 设置：左侧选择 Set variable，右侧选择变量 Roller_Visible，并添加

“，0”。 
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要触发 Symbols 动画，还需要添加 Hot Region，点击菜单 Insert->Objects->Hot 
Region，则在合适的位置插入 Hot Region，例如需要在电机的位置上弹出菜单，则

把 Hot Region 放置在电机上，Hot Region 的大小和位置可通过拖动鼠标调整，能完

全覆盖住电机即可。 

 
选中 Hot Region 后，点击右键菜单的 Properties…，在其属性窗口中，Command 

Type，选择 Menu，Command 选择 DaoSi_Motor，即前面建立的 Menu。ToolTip，选

择 Pump_ToolTip，工程运行时，当鼠标移动到电机上时，会自动弹出 Pump_ToolTip
注释的消息（Click me to activate the command）。 

点击菜单 Resource->Strings，弹出 String Table 窗口。在此窗口可以添加新的

String，比如其 ID 设为：Pump_ToolTip，其 String 设为：Click me to activate the 
command。 

 
工程运行时，当鼠标移动到电机上时，弹出 Click me to activate the command 消

息，点击鼠标，则弹出菜单 Start the Motor 和 Stop the Motor，如下图。点击 Start the 
Motor，则 Roller_Visible 的值为 1, 电机上的绿色 ON 标签可见，同时灰色辊子上

的绿色椭圆可见，表示导丝机电机控制的这部分正常工作。若点击 Stop the Motor，

则 Roller_Visible 的值为 0，电机上的绿色 ON 标签和灰色辊子上的绿色椭圆都不
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可见，表示导丝机电机控制的这部分停止工作。 

 
导丝机油泵，油浴槽油泵和油浴槽风机的控制和触发与导丝机电机的控制和触

发类似。 

 添加旋转动画 

在风机上添加一个风扇，当风机工作时，风扇旋转，否则，风扇停止转动。按

照前面一章中3.11.2里所讲的方式制作旋转风扇。控制风扇转动的变量选择

JinYou_Oil，当风机开始工作时，JinYou_Oil的值为1，风扇开始转动。 

注意，风扇旋转过程中的几个位图制作成绿色的，风扇停止时的位图制作成灰

色的。这样当风机工作时，呈现的是一个绿色的旋转风扇，而停止时，呈现的是一

个灰色的风扇。 
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4.4 Line2画面 

Line2画面由第一牵伸机、油浴槽、第二牵伸机和蒸汽加热箱部分组成，需要控

制的有第一牵伸机和第二牵伸机的电机和油泵，油浴槽和蒸汽加热箱的油泵和风机，

各个部分的控制和触发与Line1相似。 

 

4.5 Trend画面 

此画面用于显示部分数据的实时曲线，即可以显示来自TwinCAT PLC的变量的变

化，也可以显示Movicon的内部变量，此工程中，显示的是内部变量。 

4.5.1 插入Vectorial Trend 

点击菜单Insert->Symbols->Vectorial Trend，在画面上插入一个Vectorial 

Trend，打开其属性窗口，修改其属性。 

 
主要修改属性窗口中的Trend选项，点击Trend选项中的按钮Vectorial Trend 

Properties，则弹出一个窗口，如上图所示。 

 General：设置趋势图中显示的内容和风格。 

Show，显示的内容，可以选择Pen，Time等多个条目。 

   Style，显示的风格，可以是水平的或竖直的等。 

   Type，运行模式。 

 X Grid：设置竖直等分线的颜色和个数。 

 Pen：设置要显示的数据，Pen 的颜色等参数。 

在 Vectorial Trend Properties 中点击 Pen，则弹出其设置窗口，见下图。 
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• 添加一条曲线，点击 Add 按钮，弹出 Pen Properties 窗口。 

 
Name，曲线的名字，例如 Curve 1。 
Variable，要显示的数据，点击右侧的箭头，可从变量表中选择，此处选择内

部变量 Curva1。 
      Val.Min，要显示的数据的最小值，即变量 Curva1 的最小值。 
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      Val.Max，要显示的数据的最大值，即变量 Curva1 的最大值。 
      Plot type，曲线的形式。 
      Pen Color 按钮和 Brush color 按钮，选择颜色。 
      Line Style，设置曲线的线宽和曲线的风格。 

• 编辑曲线，选中要编辑的曲线，例如 Curve 1，点击 Edit 按钮，弹出其属性

窗口，修改后关闭即可 
• 删除曲线，选中要删除的曲线，点击 Remove 按钮即可。 

 Execution：设置采用频率，刷新时间，采样个数等。 

 
 Variables：Start/Stop，选择一个 Bool 型变量 Start_Trend，用于启动和停止曲线

的刷新。 

 
 
4.5.2 添加按钮 

为了在线更改数据，显示曲线的变化，在画面添加几个按钮。 
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打开其属性窗口，Style中的Title设为Set Curve1。Execution，左侧选择Set 

Variable，右侧选择变量Curva1。工程运行时，点击此按钮，则弹出变量Curva1的

编辑窗口，改变其值的大小，以显示其对应曲线的变化。 

除了添加用于改变变量值大小的按钮，还要添加一个按钮，用于启动和停止曲

线的刷新。其Title属性设为Start/Stop， Execution属性的设置如下图。 

 
工程运行时，点击此按钮就可控制曲线是否刷新了。 

 

4.6 Alarm画面 

Alarm 画面用于显示报警信息。 

4.6.1 插入 Alarms 

点 击 菜 单 Resource->Alarms/Messages Editor 或 按 F8 健 ， 打 开

Alarms/Messages Editor 窗口，在此窗口编辑报警信息。 

 
例如要设置变量 Curva3 的报警信息，当 Curva3>=90 时产生 HighHign 报警，

Curva3>＝80 时产生 High 报警，Curva3<=15 时产生 Low 报警，Curva3<=10 时产生

LowLow 报警。 
点击按钮 New，弹出 Insert New Alarm 窗口。 
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 Type，选择 Analog，由于 Curva3 是模拟量。 
 Name，报警的名字。 
 Device name，设备名，即哪台设备出现报警。例如，如果 Curva3 是设备导丝机

的电机的速度，则设备名应为导丝机电机。 
 Variable，本例中是 Curva3。 
 Text，出现报警时显示的报警信息，即在 String Table 窗口中编辑的信息。 

点击 OK 按钮即可。此时，Alarms/Messages Editor 窗口如图所示： 

 
选中 LowLow 所在行，则可编辑 LowLow 报警。 

 
根据要求，LowLow 报警的门槛值是 10，所以将 Threshold 修改为 10。Text，

选择出现 LowLow 报警时的报警信息，应当选择 LLAlarm3，LLAlarm3 表示的信息

是“Curva3 Low Low Alarm”。 
类似地可编辑其 Low 报警，High 报警，HighHigh 报警。 
在 Alarms/Messages Editor 窗口，把所有需要报警的变量按照 Curva3 的编辑方

法完成编辑。 
 

4.6.2 显示 Alarms 

在 Alarm 画面点击菜单 Insert->Symbols->Template from Library，弹出

Template Libraries 窗口，选择 Viewers CE 选项，选中 symbol “Alarms window for 
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Windows CE”，双击后在弹出窗口点击 OK 按钮，则 symbol 插入到画面中。 

 
 

插入 symbol 后的 Alarm 窗口如下图所示。 

 
工程运行时，若 Curva3 等变量出现报警，则显示在窗口中。 
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4.7 Movicon工程导出到CX1000 

把在PC机上开发的HMI导出，点击菜单File->Export Project to WinCE，则在

PC机上开发的HMI（CXTest）所在的路径下多出一个文件“CXTest_CE”，把CX1000

远程接管后，把“CXTest_CE”、“TwinCat.DVI”以及工程中用到的BMP文件用U盘

或者读卡器拷贝到CX1000中的某个新建文件夹下，例如，Hard Disk\MovCE\CXTest

下。  

说明：“TwinCat.DVI”文件用于Movicon和TwinCAT设备的通讯。 

 

4.8 在CX1000上运行Movicon HMI以及设置HMI开机自启动 

Movicon CE.NET运行核在CX1000中安装后，在CX1000的Hard Disk\MovCE下有一

个带Movicon图标的MovCe.exe文件。 
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双击该文件则弹出一个对话框： 

  
选择要启动的程序，例如CXTest_CE.PRJ文件，然后点击对话框右上角的OK按钮，则

开始运行该HMI。 

由于Movicon软件在CX1000上安装后，在Hard Disk\MovCE下有一个DemoCE工程，

它是一个开机自启动的演示程序，如果用CXTest工程替换掉DemoCE，则CXTest成为

开机后自启动的HMI。操作如下： 

 对Hard Disk\MovCE下的DemoCE文件夹重命名，例如DemoTest（删除该文件夹也

可以）。 

 将拷贝到Hard Disk\MovCE下的CXTest文件夹中的文件CXTest_CE.PRJ重命名为

Demo_CE.PRJ，将CXTest文件夹重命名为DemoCE。 

上述操作完成后，将CX1000断电并重新启动，可看到编制的Movicon HMI在

Window CE.NET执行完之后，自动启动执行。 

注意：DemoCE文件夹的路径不可修改，必须在Hard Disk\MovCE下。 

 

4.9 在 CX1000 上安装 Movicon 序列号 
在 CX1000 中，要实现 Movicon HMI 和 TwinCAT PLC 的通讯，必须在 CX1000 中

安装 Movicon CE 的 License。如果从倍福订购 Movicon CE.NET 运行核，则会得到

一个 Movicon CE 的 Serial Number。 
在 CX1000 中运行开发的 Movicon HMI，则弹出下面的窗口： 

 
把 Site Code 中的代码，即 D4AAB700A49401C2 记下来，连同购买 Movicon CE.NET

运行核时得到的 Serial Number 和 Product's Code 一起告诉 Movicon 的 Support，

他们会返回一个 License，把返回的 License 输入到 Site Key 中，则生效，以后不
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会再弹出此窗口。 

 

说明：Movicon Support的E-mail：support@progea.com
 
注意：Site Code 中的代码在 CX1000 每次重新上电，运行 Movicon HMI 时会有变换，

为使其不变，则在 CX1000 窗体中，点击开始菜单“开始->挂起”，这样 Site Code
中的代码则固定下来。为安全起见，对 CX1000 重新上电，再检查一下 Site Code，
确保其不变。 
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5. 技术服务 

本文简要讲述了如何使用 Movicon 开发基于 Windows CE.NET 的 HMI，如果您有

不清楚的地方，请致电德国倍福上海代表处，我们将竭诚为您服务。 

 

德国倍福电气有限公司上海代表处 

地址：上海市延安东路222号外滩中心3603室 

网址：http://www.beckhoff.com.cn 

电话：(021) 63351366 63291558  

传真：(021) 63351355 
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